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4. EXPLORER 

This module provides a clear overview of all the colour, material and image data as well as users’ own 
projects and favourites. The extended search allows allows specific selection of colours and materials. 
New surfaces can be added via the online material database. 

This chapter explains the individual EXPLORER tabs and their functions in detail.

4.1 Menu bar

4.1.1 Data views

You can choose between three different views for presentation of the example images, colours and materi-
als in the SPECTRUM 4.0 database:
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Small        
This provides you with a minimalised view of all images, colours and materials without any further product 
information. This view is ideal for looking at as many products as possible at once.

Medium      
This view provides you with a larger presentation of the product as well as the product name and the pos-
sibility of receiving adetailed information display (for information about the details see chapter 4.2.2 “Col-
our details” and chapter 4.2.3 “Material details”). This view is particularly suitable for having a look at many 
products at once and finding out first product information. Products are shown in the medium sample view 
as standard.

Large        
This view shows the images, colours and materials in a large view with the possibility of a detailed infor-
mation display (for detailed information see chapter 4.2.2 “Colour details” and chapter 4.2.3 “Material 
details”). It is especially suitable for viewing product details at the search stage.

Note: You can alternate between the there data views by clicking “View” in the menu bar.
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4.1.2. Search

You can use the search function in the menu bar for all the EXPLORER tab contents except for the online 
material database. If you are in the “Colour” tab, for example, you can enter the name of a colour in the 
search field, which will result in all the colours with this generic name being displayed. Always confirm your 
entry by pressing the “Enter” key or clicking the magnifying glass symbol to trigger the search.

Extended search for colours and materials
With the new program version, SPECTRUM 4.0 provides extended functions to optimise your product 
search within the “Colour” and “Material” tabs. 

To use the new search functions, click “extended search” in the menu bar of the 
EXPLORER. In addition to the tabs, a further field opens which offers you two different search possibilities: 
Colour range and full test search.
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Colour range
To limit your search within a colour or material collection, you can choose from fourteen given colour 
ranges. You are then shown a window with all database entries in the respective colour range. The colour 
range chosen is indicated by a white frame. Several colour ranges can be marked at the same time. Click-
ing on a selected colour field again deactivates it.

Full test search
If you already know the name of the colour or material you are looking for, you can enter the text and use 
this function to search for it.

Note:The full text search can be restricted by marking “colour ranges” in the colour range search first. A 
second click on the selected colour range boxes deactivates the selection. You have deactivated the col-
our range search correctly when there is no longer a white frame around one of the fourteen colour range 
boxes. Now you can carry out the full text search without restrictions.

To remove your search criteria, click “reset”, to close the “extended search” window click the “x” in the top 
right-hand corner.
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4.2 EXPLORER tabs

On the left-hand side of your workspace, the EXPLORER gives you an overview of all the SPECTRUM 4.0 
database contents in the categories:

Click on the different tabs to move between them.

4.2.1 Library

The library provides an overview of all the image data (example images and your own imported images) 
that you can work with in SPECTRUM 4.0. This is where you create and manage your own projects.

Example images
You can find more than 200 example images from different countries in SPECTRUM 4.0.

Image selection 
You can choose between the categories “My projects” as well as “Example images” with the sections “In-
terior” and “Exterior” (façades). In the “Interior” category you will find prepared images from the segments 
living, hallways, classrooms etc., in the “Exterior” category family homes, apartment buildings or timber-
framed houses, for example. In the “My projects” section you will find the project data you have created 
(for information on your own projects see “My projects”).
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The list of sub-categories can be faded in or out by clicking the +/- symbol (in front of the respective cat-
egory name “Interior”/“Exterior”). 

In order to view the example images from one sub-category (e.g. Living, Restaurant, ...) select this by 
mouse click.

Loading an image into PHOTOstudio for design work.
Double-clicking an image in the workspace will load this directly into PHOTOstudio for design work. The 
SPECTRUM 4.0 program interface changes to the PHOTOstudio module 
(PHOTOstudio see chapter 5).

My projects
When you create your own projects, SPECTRUM 4.0 gives you the possibility of saving image and mate-
rial data in a self-created project folder, helping you to manage the data easily. “My projects” can be found 
above the example images in the “Library” tab. The “My projects” folder remains empty until the first “new 
project” has been created.

Create new project
To create a new project, click on the “New” symbol in the top area of the “Library” tab or use the main 
navigation “File”>“New”>“My project”. Alternatively, right-click on an existing project and select “Create 
project folder” (shortcut: Ctrl+N). The window “Project details” will open for assignment of a project name. 
Additional information about the project concerned, such as name, contact data and remarks can all be 
entered here. 
Give the project an unambiguous project name (e.g. “The Jones family”). Other information can be added 
to the project later. Then click “Save”. The newly created project folder will now appear your “My projects” 
list.

See chapters 5 “PHOTOstudio” and 7 “MATERIALstudio” for information about how to add designed im-
age data or new material combinations to your project folder.
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Edit project details
To change project information, for example in order to add a remark or address data, double-click or right-
click the project concerned and choose “Edit project details”. The “Project details” window opens again. 
Confirm your changes by clicking “Save”.

Delete project
In order to remove an existing project irrevocably from the list of your self-created projects, first select the 
project concerned by clicking the project name (it has been selected when the project name is highlighted 
blue and the contents are shown in the workspace). Click the “Delete” button or right-click the project 
name and remove the project using “Delete project folder” (shortcut: Del).

Note: Projects that have been deleted cannot be recovered. For this reason, only delete a project when 
you are sure that the projects and its contents are no longer needed.

Import image data
To import your own image data to SPECTRUM 4.0 use the main navigation “File”>“New”>“Import image 
data”. When the dialogue window opens, you can access the data on your PC or data carrier (e.g. USB 
stick) and select the image you want. Click “Open”, choose the respective target project folder and give 
the image an unambiguous name. Then click “Save” and the image appears in the selected project folder.
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Import Spectrum 3.0 data
The image data you processed in SPECTRUM 3.0 are not lost in the new SPECTRUM 4.0 program ver-
sion. You can access your Spectrum 3.0 image database via the function “Import Spectrum 3.0 data” 
which you reach via an existing project or “File”>“New” (pre-condition: you are using SPECTRUM 4.0 on 
the same PC). First of all, choose one of your SPECTRUM 3.0 project folders in the window that opens 
and then a SPECTRUM 3.0 IMAGEstudio project from this project folder in the next step. You will see a 
preview of the selected image in the bottom right-hand window, and you can give the image to be import-
ed a new name under “New variant name”. Then click “Import” to save the selected image in the project 
folder.

Pack‘n‘Go
The Pack‘n‘Go function is used to exchange image data including all surfaces, grids and SPECTRUM 4.0 
design between different PCs. Use the Pack‘n’Go functions of the program to export and import image 
data. 

Pack‘n‘Go Export
To export an image, select the respective image in a project folder and then select “Edit”>“Pack‘n‘Go 
(Export)”. A window opens where you can choose the target folder you want for the image (e.g. an external 
data carrier such as an USB stick). Confirm with “OK” and the image will be exported to the target loca-
tion.

Pack‘n‘Go Import
In order to import an image exported with Pack‘n‘Go to SPECTRUM 4.0, right-click on the project 
folder the image is to be imported to and select “Pack‘n‘Go (Import)” or use the main navigation under 
“Edit”>“Pack‘n‘Go (Import)”. A window will open where you can access the data on your PC. Choose 
the image you want from your hard drive or an external data carrier and click “Open”. The image is now 
imported to the project file.
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4.2.2 Colour

In the “Colour” tab you will find all the colours of the colour collections from Caparol, RAL and NCS for use 
for your colour designs.

Colour selection
When you click the main category “All colours” you will be shown all the colours available in the SPEC-
TRUM 4.0 database. In addition, you can refine your search by selecting manufacturers and individual 
collections. Click the “+” in front of the manufacturer’s name to see the respective collection list.
If you click a manufacturer’s collection, you will be shown all the colours in this collection.

Colour details
Information about the name and further details about the colour can be obtained with the “medium” and 
“large” views (“Data views” see chapter 4.1.1) by clicking the “i” at the bottom right-hand edge of a colour 
image in the workspace.

A window opens in the foreground containing an enlarged image of the colour and details of manufacturer, 
collection, name, RGB or LCH values, brightness reference value and colour family. 
In addition, you can save the colour as a jpeg, TIFF or PNG file on your PC. To do this, click the “Save” 
symbol, give the file a name and click “Save”. To print the colour, click the “Printer” symbol. SPECTRUM 
4.0 will automatically create a PDF file that you can both save and print out.
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You can access the website of the respective manufacturer by clicking the “www” button in the top right-
hand corner of the window; further information about the colour and collection will be provided here. The 
“Back” button will take you back to the colour detail view.

To close the colour details, click the “X” at the top right-hand edge of the window.

4.2.3 Materials

The material database tab contains textures from Caparol as well as example surfaces from other well-
known manufacturers that are available to you for design purposes. In addition, you can download materi-
als from other manufacturers from the online material database (see chapter 4.2.4 “Online material data-
base”). 

            

Material selection
When you click the main category “All materials” you will be shown all the materials available in the SPEC-
TRUM 4.0 database. In addition, you can refine your search by selecting manufacturers and individual 
material collections. 
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Click the “+” in front of the manufacturer’s name to open the respective collection list.
If you select one single collection from the manufacturer by mouse click, the contents of this collection will 
be displayed.
The total number of materials loaded and thus available for design purposes is shown at the top right-hand 
edge above the workspace.

Material details
Information about the name and further details about the material can be obtained depending on the view 
selected (“Data views” see chapter 4.1.1) by clicking the “i” at the bottom right-hand edge of a material 
image in the workspace. 

A window opens in the foreground containing an enlarged image of the material and details of manufac-
turer, collection, name, article number and colour family. 
In addition, you can save the material as a jpeg, TIFF or PNG file on your PC. To do this, click the “Save” 
symbol, give the file a name and click “Save”. To print the material, click the “Printer” symbol. SPECTRUM 
4.0 will automatically create a PDF file that you can both save and print out. 
Technical Information (TI) and the Safety Datasheet (SD) for Caparol materials can be found using the “TI” 
and “SD” buttons in the middle of the top edge of the material data window (providing you are connected 
to the Internet).
You are linked to the website of the respective manufacturer by clicking “www” at the top right of the win-
dow. The “Back” button will take you back to the material detail view.

To close the material details, click the “x” at the top right-hand edge of the window.
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4.2.4 Online material database

Use the online material database to download current collections from different manufacturers free from 
the Internet.
This way you load the latest materials and colours directly into your SPECTRUM 4.0 software and can use 
them directly for individual design purposes.

How it works
Open the “Online material database” tab. Depending which range you would like to download the da-
tabase contents from, you can choose between materials, colour collections, example images and the 
MATERIALstudio.

Materials
Click here for updates from the material collections of individual manufacturers.

Colour collections
Click here for updates from the colour collections of individual manufacturers.

Example images
You can find further example images to supplement your SPECTRUM image database here. You can also 
find image material from the predecessor version SPECTRUM 3.0 here.

MATERIALstudio
Here you can find further material structures that you can combine into new material combinations in the 
MATERIALstudio module (see chapter 10 for myMaterial-Manager).
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For each category you can find a selection of sub-categories with all the collections available. Choose the 
collection you would like to download. A “Download” button will appear in the lower area of the SPEC-
TRUM 4.0 program interface. The required data is integrated directly in your SPECTRUM 4.0 database 
after this button has been clicked.

If you already have the product data from a sub-category, the category name is shown in grey and has a 
white tick mark next to it.

Note: The SPECTRUM 4.0 NewsletterService, which you can subscribe to through www.spectrum-online.
eu or by registering directly in the program (main navigation under “Extras” “Register”), provides informa-
tion about new collections.

4.3 Favourites

You can save certain colours or materials that you use regularly under “Favourites”- The EXPLORER fa-
vourite view is underneath the interface. Add favourites to the “SPECTRUM 4.0” standard folder or create 
your own new favourite sets and fill these with the colours and materials you require.
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Add samples to set of favourites
Add a colour or material to a set of favourites by simply clicking the sample in the workspace (a sample 
becomes light grey when the mouse is on it - samples that are already stored in the selected set of favour-
ites  are shown with a dark-grey edge). A second click on the product removes it from the set of favourites 
- alternatively you can click the small “X” at the top right-hand edge of each individual sample in the set of 
favourites.

Note:Products you add to favourites are automatically saved and are available as individual archives when 
working with SPECTRUM 4.0 until you delete them.

Choose favourites
To choose colours and materials within a set of favourites, move the mouse over the favourites cards. The 
card your mouse is resting in is accentuated so that it can be seen better. If you have a long list within a 
set of favourites, use the scroll bar at the bottom edge of the window to search through the contents.

Create new set of favourites
Alongside saving colour or material samples in the set of favourites “SPECTRUM 4.0”, it is possible to 
create further sets of favourites that you can fill with the colours and materials used for certain projects, for 
example. 
Add a new set of favourites by clicking the “star +” symbol in the favourites tab. A window opens for you 
to enter a name for the new set of favourites. After confirmation by “OK” the new empty set will automati-
cally appear in the dropdown menu of the “Favourites” tab. Fill your set of favourites by clicking individual 
colour and material samples in the colour and material tabs (see “Add samples to favourite set”).

Note: Samples selected are always added to the set of favourites currently being shown in the dropdown 
menu. For this reason, always select the required set of favourites before you add further samples.
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Delete set of favourites
If you would like to remove a complete set of favourites with all its contents from the favourites tab, first 
choose the set to be deleted in the dropdown menu. Then click the 
“star -” symbol in the “Favourites” tab and confirm your choice by clicking “Yes” in the window that opens. 
The set of favourites is no longer in the dropdown menu selection and has been irrevocably deleted.

Clear set of favourites
To delete a sample from a set of favourites, click the “X” at the top right on the respective sample. 

If you would like to delete the entire contents of a set of favourites, click the empty “star” symbol (“Clear 
favourites”) in the favourites tab. The set of favourites itself is retained and can be refilled. 

Embed personal pictures)
You can also add your own images to a set of favourites (e.g. if you would like to use this as photo wallpa-
per or a wall mural).
To do this, click the “flower” symbol (“Embed personal pictures”). In the window that opens, select an im-
age from your PC or an external data carrier by clicking “Open folder” on the top left, and load it into the 
window by clicking “Open”. Then specify the required width and height in cm for your image. Then click 
“OK” – the image now appears in the set of favourites you have currently selected.
If you would like to import your image in an unproportional size, deactivate the tick between height and 
width and enter the measurements you require. Your image is then imported distorted accordingly.

Note: Bear the size of the respective area required for the image in the PHOTOstudio when selecting your 
image measurements.


